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5 CLSS Canada Lands In Google Earth 

 
 WHICH TOOL SHOULD YOU USE? 

There are four methods of conducting searches for Canada Lands Survey Records (CLSR). These 
include: 

CLSS Map Browser – an interactive, map-based plan and parcel 
search tool 

Canada Lands in Google Earth – an overlay providing an integrated 

view of boundaries and parcels in Google Earth 

Survey Plan Search – a text-based search tool for all current and 
historical records 

Survey Project Search – a text-based search tool for in-progress 
survey projects 

The following pages will help you determine which tool to use to find the information you seek. 

http://clss.nrcan.gc.ca/map-carte-eng.php
https://www.nrcan.gc.ca/maps-tools-and-publications/maps/canada-lands-surveys/tools-applications-canada-lands-surveys/11094#c2
http://clss.nrcan.gc.ca/clss/plan/search-recherche
http://clss.nrcan.gc.ca/clss/project-projet/search-recherche
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If I know the lot number I am looking for? 
The Map Browser Search tool and the keyword search of the Survey Plan 
Search tool allows searching for a lot or a parcel number. See example in 
the Map Browser Help Manual on page 22. 

If I have a plan number? 
The Survey Plan Search tool is the easiest way to find a survey plan if 
you know the plan number. See example 2 of the Survey Plan Search 
Help Manual on page 16.  

If I know exactly where to look on a map to find the information I 
need? 
Google Earth and the Map Browser allow you to navigate to the 
parcel or to the area you are looking for. Note that Google Earth only 
shows the most up-to-date parcels. See example 1 of the Google 
Earth Help Manual on page 22. 

If I want to find one or more active or inactive parcels 
using only the Canada Lands name ? 
Depending on the input and the type of search, all tools would 
work except Google Earth that only shows the most up-to-date 
parcels. See the example in the Map Browser (page 22), the 
example 1 in the Survey Plan Search (page 14) and example 2 
in the Survey Project Search (page 15) Help Manuals. 

 
 WHICH TOOL SHOULD YOU USE? 
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If I want to see the most recent parcels over an aerial 
photograph? 
Google Earth is the only tool that allows for viewing the parcels over 
aerial imagery. See "How to Search" of the Google Earth Help Manual 
on page 15. 

If I have a project number from the Canada Lands Survey 
System? 
If you know the project number, the Survey Project Search tool 
allows to find any open and/or closed projects. See example 2 of 
the Survey Project Search Help Manual on page 15.  

If I know the name of the land surveyor? 
Surveys by a Canada Lands Surveyor can be found using the 
Surveyor field of the Survey Plan Search and the Survey Project 
Search tools. See "How to use Survey Project Search" of the 
Survey Project Search Help Manual on page 10. 

If I am looking for a parcel designated for a specific use (road, 
park, school, etc.) ?  
Using the Survey Plan Search or the Survey Project Search tools, it is 
possible to do a keyword search. See example 3 of the Survey Plan 
Search Help Manual on page 18.  

If I am looking for a specific type of document or a specific 
type of survey plan (condominium, mineral claim, right of 
ways) ? 
Using the Survey Plan Search tool, it is possible to filter the results 
according to the type of documents or the purpose of the survey. See 
"How to use Survey Plan Search" of the Survey Plan Search Help 
Manual on page 10. 
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OVERVIEW 

Canada Lands include the Yukon, Northwest Territories and Nunavut; more than 3,100 Indian 
Reserves; Canada's National and Historic Parks; and Canada's offshore area. 

The Canada Lands Survey System (CLSS) provides the framework for defining, marking, and 
describing the boundaries of Canada Lands. 

Survey records are the legal survey documents (plans, field notes, reports, diaries). 

Survey plans, information on surveys in progress and geospatial representations of parcels of 
Canada Lands are all accessible online. 

This guide focuses on Canada Lands in Google Earth. 

Canada Lands in Google Earth allows you to see the cadastral fabric or latest surveys and 
administrative boundaries of Reserves, National Parks and territories over Google Earth imagery, 
and to find the plans relating to those parcels. 

TIP:
Canada Lands in Google Earth is a good way to quickly reference plans 
relating to current parcels. The tool also allows users to zoom in close 
to areas they are interested in. 
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INFORMATION FOR LAND ADMINISTRATORS 
Survey systems provide land administrators with the location and size of parcels of land, allowing 
them to manage property rights. 

Survey plans and cadastral datasets for geographical information systems (GIS) are available to 
support land administrators with interests in Canada Lands. 

The survey plans define boundaries, while the cadastral datasets are amalgamations of all the 
parcel and plan information. The cadastral dataset is a valuable tool to support planning and 
management, but should not be used for defining boundaries. 

Survey plans on Canada Lands are recorded in the Canada Lands Survey Records, which are 
updated regularly and reflect the most recent recorded survey information. 

TIP: For definitions of unfamiliar terms, refer to the glossary on page 28. 
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BEFORE YOU BEGIN 

Browser Requirements: The CLSS Map Browser is designed to work in various web browsers and 
no plugins are required to access the application. However, other data accessible through the 
browser, such as survey plans, requires the use of third-party applications to view the plan 
images. 

JavaScript must be enabled. 

The DjVu browser plug-in (Opens in new window) from Caminova inc. is required to view DjVu 
files. 

Disclaimer: 

Canada Lands Digital Cadastral Data provides the cadastral parcel framework for specified Canada 

Lands. It can be used to view the administrative boundaries and cadastral parcels within Indian 

Reserves, National Parks and the territories. By using this data, it is important to understand and 

accept that the data is not to be used for defining boundaries. Administrative decisions should be 

based on legal documents and survey plans. 

TIP:
KMZ stands for Keyhole Markup language Zipped. It is a compressed version of 
a KML (Keyhole Markup Language) file, which is the file format that Google 
Earth uses to store information. The Canada Lands KMZ allows for image 
overlays in Google Earth, as well as other KML readers. 

 

http://www.caminova.net/en/downloads/download.aspx?id=1%27)%20?%3E
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GETTING STARTED 

Install Google Earth Pro 
1. Download Google Earth Pro. https://www.google.com/earth/versions/#download-pro
2. Double-click the file and follow the installation process.
3. To open Google Earth Pro, click Start > Programs > Google Earth Pro. Then, click Google

Earth Pro.

Download the Canada Lands KMZ file from the link on the CLSS page. 
Open the CLSS Canada Lands in Google Earth English version using a web browser of your 
choice: Microsoft’s Internet Explorer, Google’s Google Chrome, or the Mozilla 
Foundation’s Firefox, using this link: 
https://www.nrcan.gc.ca/maps-tools-and-publications/maps/canada-lands-surveys/
tools-applications-canada-lands-surveys/11094#c2  

From this page you can download the Canada Lands Overlay by clicking where indicated 
below.  

Click 

https://www.google.com/earth/download/gep/agree.html
https://www.google.com/earth/versions/#download-pro
https://www.nrcan.gc.ca/maps-tools-and-publications/maps/canada-lands-surveys/tools-applications-canada-lands-surveys/11094#c2
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Drag the downloaded file into My Places in the menu on the left-side of the Google Earth screen. 

This ensures that Canada Lands dataset will be available to you the next time you open Google 
Earth. It will not need to be downloaded again. The next time you open Google Earth from your 
desktop, the Canada Lands information will be available there. 

Data is always current because you download a link to the data that gets automatically updated. 

Canada Lands will be added to My Places in Google Earth and will remain active and up-to-date 
until you delete the KMZ file. 

TIP:
The KMZ file is designed to work best with Google Earth 4.2 or later versions, 
but the format is also compatible with Google Maps, Google Maps for Mobile, 
Microsoft Virtual Earth, and NASA's World Wind. 

 



January 2020 | Version 3.1 

13 CLSS Canada Lands In Google Earth 

USING GOOGLE EARTH 

How to Navigate 

The navigation controls are in the upper right corner of the map and fade when you are not 
using them. 

 To show navigation controls, move the mouse over the right corner of the map. 
 If you do not see the navigation controls, in the top menus, click View > Show 

Navigation > Automatically. 
 Show or hide the compass: In the top menu, click View > Show Navigation. 

• Use look (top of the controls) to look around from one vantage point.
• Click and drag the ring to rotate the views.
• Use move (center of the controls) to move down, up, right, or left.
• Use the zoom slider to zoom in or out (+ to zoom in, - to zoom out).
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What you will see 

In most cases, Canada Lands in KMZ format have four levels of detail: 
1. A general point location of the Canada Land for viewing at large extents
2. Zooming in on the point will load the administrative boundaries
3. Zooming in further will transition the display to parcel level data
4. Clicking on the place marks at the centre of each parcel will display and link to further

cadastral information.
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HOW TO SEARCH 

Do not use this 
Search tool as it 
searches on 
Google and not 
within the Canada 
Lands KMZ file.  

Select 
province 
or 
territory 

Find 
Canada 
Land 
name in 
dropdown 
list or type 
name 
here 

To search: 
1. Select the province or territory from the list of options.
2. Type the Canada Land name or select from the dropdown list, and then double-click on
the desired option from the list that appears.
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Your result will look like this: 

TIP: Push the R button on the keyboard every time you zoom or move, to get 
a bird’s eye view instead of a perspective or rotated view. 
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Hover your mouse over the lots to have the names appear (Parcel designators), and then click on the 
name, which will show the CLSS information in a popout window.

Hover 
mouse 
over the 
lots to 
have the 
names 
appear 
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HOW TO READ YOUR RESULTS 

Click on the link for 
English to open the 
Survey Plan Details 
window where the 
plan can be 
downloaded.  

Download Digital 
Cadastral Data 
(See page 20)  

This links to Map 
Browser, zooming 
to the relevant 
parcel. 

In the Canada Lands KMZ Overlay, when zoomed in to the parcel level data, clicking on the 
centre place mark will display: 

• Description — Describes the type of parcel, such as LAND PARCEL, MINERAL CLAIM, 
EASEMENT, etc.

• NRCan PIN — The unique identification number created by NRCan for each parcel.
• Parcel Designator — Name of the Land Parcel shown on legal survey documents, which 

usually includes the lot number.
• Plan Number — Click on the link for English to open the Survey Plan Details window 

where the plan can be downloaded.
• Administrative Area — The Canada Land administrative area, this parcel is associated 

with (Reserve, National Park, etc.)
• Download Digital Cadastral Data link (See page 20).
• Interactive Map — A link to Map Browser, which once selected will zoom to the 

relevant parcel after a few moments. 
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Clicking the English link takes you to the Survey Plan Search tool. See the Survey Plan Search 

guide for more information. 

To return, click the Back to Google Earth button. 
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SEARCH RESULTS TIPS 

Trouble viewing land parcels 

If you are having difficulty 
viewing the land parcels, 
turn off the Terrain Layer, 
which makes Google Earth 
3D and sometimes 
interferes with the lines.  

Accessing FTP links from Google Earth 

The “Download Digital Cadastral Data” links in Canada Lands in Google Earth point to an FTP 
site. Default security settings in Google Earth do not allow users to open these links directly 
from the application. 

To access the data, copy 
the Download Digital 
Cadastral Data links into a 
web browser address bar 
by right-clicking the link 
and selecting Copy Link. 
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Settings in Google Earth can also be changed to allow the opening of FTP links. These changes 
should only be made if you agree with the security impact to your computer. From the menus, 
select Tools > Options and select the “General” tab. Next, check the options Display > “Show web 
results in external browser” and Placemark balloons > “Allow access to local files and personal 
data.” 
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SEARCH EXAMPLES 
EXAMPLE 1: If you are looking for a certain lot, you can navigate to the lot if you know 
where it is located. This allows you to find specific information about the lot, such as the Plan 
Number. 

 

Select British Columbia, 
and then begin typing 
the name of the Reserve. 
A list of options will be 
provided. Select Kitselas 
Reserve from the list, 
and double click.  

TIP: Keep in mind that a First Nation might have multiple reserves.

This example uses 
Kitselas Reserve No 1, but 
there are other reserves 
for Kitselas First Nation 
(Chimdimash 2 and 
Chimdimash 2A).   
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The search produces this result: 

Hover mouse over the lots to have the names appear, or zoom in closer to find the specific lot 
you are looking for. 
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SEARCH EXAMPLES 
EXAMPLE 2: If you are looking for lot 106 on Mistawasis Reserve No. 103 but you do not know 
where it is located, you can expand the dropdown list of Mistawasis Reserve No. 103 and scroll
down to lot number 106 within the layer Land_Parcel__Parcelle_de_terre. Double-click to  
zoom on the parcel and to open the information page for lot 106. 

Select Saskatchewan, and 
then begin typing the 
name of the Reserve. A list 
of options will be 
provided. Select 
Mistawasis IR 103 from the 
list, and double click.  
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The search produces this result: 
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Then type the number of the lot you 
are looking for. The parcels 
corresponding to 106 will be displayed 
successively. Double-click to zoom on 
the parcel and to open the lot 106 
information page. 

TIP: 
When you become comfortable with Canada Lands in Google Earth you can use the 
many tools of Google Earth. For more information, select Help Resources under the 
Help tab. 
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HELP 

To access Google Earth online help, go to: 
https://support.google.com/earth/?hl=#topic=7364880 

NEED MORE HELP? 

For terms and abbreviations please refer to the glossary. 

For help with survey plans, please refer to the National Standards for the Survey of Canada Lands 
and the Interdepartmental and Intergovernmental Agreements. 

For any other information, contact your Surveyor General Branch Regional Office: 

• Alberta Regional Office
• Atlantic Regional Office
• British Columbia Regional Office
• Manitoba Regional Office
• Northwest Territories Regional Office
• Nunavut Regional Office
• Ontario Regional Office
• Quebec Regional Office
• Saskatchewan Regional Office
• Yukon Regional Office

https://support.google.com/earth/?hl=#topic=7364880
http://clss.nrcan.gc.ca/clss/surveystandards-normesdarpentage/
http://clss.nrcan.gc.ca/clss/surveystandards-normesdarpentage/agreements
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#ab
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#ns
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#bc
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#mb
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#nt
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#nu
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#to
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#qc
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#sk
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#yt
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 GLOSSARY

Administrative Area 
The spatial extents of a jurisdiction created by combining all the associated parcels 
together. These areas are generally Indian Reserves, Indian Lands, Settlement Lands, 
National Parks, and Territorial Parks. 

Administrative Plan 
A plan created for administrative purposes and prepared under Section 31 of the 
Canada Lands Surveys Act. They are used for defining boundaries or parcels and they 
are approved by the Surveyor General before being recorded in the CLSR. 

Air Space Parcel Survey 

An air space parcel survey is a survey that describes a volume of space. Examples 
include underground tunnels, bridges, and overhead walkways. Air space parcel 
boundaries are independent of physical structures, and are defined by plane or 
curved surfaces that have three-dimensional coordinates. 

Allotment The process by which an individual or a group receives lawful possession of reserve  
land from the Band, the First Nation Council, or any other body entitled to assign land. 

Artificial Boundary 
An invisible boundary defined by a straight line, a circular curve of known radius, 
or, in rare cases, a spiral curve. A rectangular parcel is usually formed by  
artificial boundaries. 

Boundary 

Boundaries of parcels are ubiquitous. They exist in the field only and are created by 
agreements between people. All peoples across all cultures mark the boundaries of 
their parcels on the ground or in the air. These boundaries can serve economic, social 
or security purposes. A boundary can be defined using artificial lines or natural 
elements such rivers or ridge lines. On Canada Lands, only a Canada Lands Surveyor 
can make the connection between the description of the land as presented on a 
survey plan and the boundary itself in the field. 

Boundary Surveys 
Regulated expertise that incorporates technical, procedural and legal aspects related 
to determining, describing and demarcating property and administrative 
boundaries. Also referred to as Land Surveys, Cadastral Surveys, and Legal Surveys. 

Cadastral dataset 

Cadastral dataset, also known as digital cadastral data or survey fabric are 
amalgamations of all the parcels and plan information. This amalgamation can 
be used to support planning and management, but should not be used for  
defining boundaries. 

Cadastral Surveys 
Regulated expertise that incorporates technical, procedural and legal aspects  
related to determining, describing and demarcating property and administrative 
boundaries. Also referred to as Boundary Surveys, Land Surveys, and Legal Surveys. 

Canada Land 
As defined in Section 24 of the Canada Lands Surveys Act, Canada Lands include the 
Yukon, Northwest Territories and Nunavut; over 3100 Reserves; Canada's National 
Parks; and Canada's offshore area. 
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Canada Lands in 
Google Earth 

Canada Lands in Google Earth is an overlay providing an integrated view of 
boundaries and parcels in Google Earth. 

Canada Lands Survey 
Records (CLSR) 

The Canada Lands Survey Records is a registry of legal survey documents and 
contains survey plans, field notes, diaries, reports and other documents to 
support property rights on Canada Lands.

Canada Lands Survey The Canada Lands Survey System (CLSS) provides the framework and infrastructure 
for defining, demarcating and describing boundaries of Canada Lands and of private 

System (CLSS) lands in the North. 

Canada Lands Surveyor Surveyors who hold a commission under Section 49 of the Canada Lands Surveyors 
Act apply mathematics, property law and use of the latest measurement technology 

(CLS) to create parcels of land and establish property boundaries on Canada Lands. 

The Canada Lands Survey System Map Browser is an interactive, map-based plan and CLSS Map Browser parcel search tool. 

Community Refers to rural and northern communities of the territories or in the provinces in 
the Canada Lands Survey System. 

A compiled plan is a plan of parcels or boundaries produced using survey field note 
information of records in the CLSR, as well as incorporating that information shown Compiled Plan on plans registered in a provincial or territorial Land Titles office. Compiled plans are 
a means to create parcels from a reliable survey fabric. 

The objective of a condominium survey or condominium plan is to divide property 
into parts to be owned individually (called “units”) and parts to be owned in common Condominium Surveys (called “common property” or “common elements”. For example, on a condominium 
plan, a building can be defined by reference to floors, walls, and ceilings. 

Control surveys provide horizontal and vertical positions of points or monuments to Control Surveys which other surveys are adjusted. 

A system that is used to calculate, map or locate the position of objects, for example 
Coordinates geographic coordinates in degrees of latitude and longitude or Universal Transverse 

Mercator (UTM) projected coordinates in metres. 

Refers to Cree and Naskapi communities in northern Quebec in the Canada Lands Cree-Naskapi Survey System. 

Digital cadastral data, also known as cadastral dataset or survey fabric are 
amalgamations of all the parcels and plan information. This amalgamation can Digital cadastral data be used to support planning and management, but should not be used for  
defining boundaries. 

A non-exclusive, limited right affecting real property allowing one party to cross or Easement use another party’s land for specific purposes. 
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Explanatory Plan 

An Explanatory Plan is a plan prepared from information found on plans and field 
notes recorded in the Canada Lands Survey Records (CLSR), and is not based upon any 
new field survey. An Explanatory Plan is used to define the boundaries of short-term 
or non-exclusive interests such as short-term leases, utility easements, access roads 
or right-of-ways, and First Nation surrender or designation votes. 

Field Book 
Surveyors use field books to record data and make notes while they are in the field. 
Some of this field book information is shown on the survey plan and/or field notes 
submitted to the Surveyor General. 

Field Notes 

Field notes are the synthesis of the data collected in the field during the execution 
of the survey. Field notes of survey prepared by a surveyor and submitted to the 
Surveyor General are filed in the CLSR in accordance with Section 18 of the 
Canada Lands Surveys Act. Field notes can be included in a survey plan or not. 

First Nation In the Canada Lands Survey System, First Nations may refer to a band or a community 
that is associated with one or more Indian reserves. 

Indian Reserve Tract of land set aside under the Indian Act or treaty agreements for the exclusive use 
of a First Nation. A reserve can be held in common between different First Nations. 

Indigenous Services 
Canada (ISC) 

ISC works and supports Indigenous peoples in assuming control of the delivery  
of services at the pace and in the ways they choose, including access and 
maintenance to land tenure systems such as the Indian Land Registry System (ILRS) 
and the First Nations Land Registry System (FNLRS) to record property interests in 
First Nations lands. 

Internal Boundary Internal boundaries mark the limits of the parcels inside a jurisdictional area, for 
examples the internal boundaries of a First Nation reserve. 

Jurisdictional 
Boundary 

With regard to land, a jurisdictional boundary is a boundary between two domains 
that have separate jurisdictions over land administration. For surveys of Canada 
Lands, jurisdictional boundaries include the boundaries of Indian Reserves, National 
Parks, and Settlement Lands in the territories. The boundary of a road vested in a 
province through an Indian Reserve or National Park is a jurisdictional boundary. 

Keyword Allows searching with keywords in the Canada Lands Survey System. The keyword 
search only applies to documents title and description. 

Land Description A description of the extent and location of a parcel defined using survey plans or 
any other documents. 

Land Registry A land registry is a set of records that anyone can search to find out what ownership, 
leases, permits and other interests may apply to a parcel of land. 

Land Surveys 

Regulated expertise that incorporates technical, procedural and legal aspects  
related to determining, describing and demarcating property and administrative 
boundaries. Also referred to as Boundary Surveys, Cadastral Surveys, and  
Legal Surveys. 
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Legal Surveys 
Regulated expertise that incorporates technical, procedural and legal aspects  
related to determining, describing and demarcating property and administrative 
boundaries. Also refer to as Boundary Surveys, Land Surveys, and Cadastral Surveys. 

Lot Normally one of a series of parcels comprising a subdivision of a townsite used 
to define the extent of land ownership or other exclusive use of land. 

Mapping Product Maps and plans other than survey plans can be registered in the Canada Lands Survey 
System. Such mapping products do not create boundaries. 

Mineral Claim Surveys Surveys whose purpose is to define boundaries of subsurface interest for lease
purposes in the Yukon, Northwest Territories and Nunavut. 

Municipal Boundary In the Canada Lands Survey System, refers to official extent of the community 
boundary as defined by territorial legislation. 

National Park In the Canada Lands Survey System, refers to Canada's National Parks included in 
Canada Lands definition. 

Natural Boundary A boundary defined by a natural feature, such as a water boundary, a watershed line, 
or a ridge line. 

Not Applicable 
The Not applicable filter can be used to search for items such as : Cancelled plans, 
Compiled plans – Where field notes only, Diaries, Sketches, NTS Map sheets, Display 
posters, Some Legal descriptions, Reports (non-survey), Mapping products, etc. 

Official Plan 

A plan confirmed by the Surveyor General under Section 29 of the Canada  
Lands Surveys Act. Boundaries defined by the monuments shown on the Official 
Plan become the true boundary lines. This type of plan is generally used for 
jurisdictional boundaries. 

Oil and Gas Wells 
and Facilities 

Limited right areas representing the spatial extent of an oil and gas well site 
or facilities. 

Oil and Gas 
Right of way

See Right-of-Way. 

Parcel 

An area of land, usually surveyed, regardless of dimensions, that is capable of  
being used to define the extent of land ownership or other exclusive use of land. 
It includes, but is not limited to, lots, blocks, subdivisions, roads, highways,  
rights-of ways, condominium units, air space parcels, etc. A parcel has defined  
limits, known as boundaries. 

Parcel Designator The name of the Land Parcel shown on legal survey documents, which usually 
includes the lot number. 
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Parcel Identification 
Number (PIN) 

Unique numbers (usually 7 to 9 digits) automatically generated by the survey system 
and the land registry system for a parcel based on the land description. Different PIN 
numbers can be assigned to a parcel, for example a Natural Resources Canada PIN in 
the Canada Lands Survey System and a Indigenous Services Canada PIN in the Indian 
Land Registry System. The parcels may also have been assigned an existing PIN, the 
same number in both systems. 

Plan See Survey Plan. 

Plan and Field Notes Survey plan and field notes combined under one plan. 

Plan Number 
Number given to the plan in the Canada Lands Survey System. This number can be a 
Canada Lands Survey Records plan (for example 106523 CLSR) or a Regional Survey 
plan (for example 5233 RSQ in the province of Quebec). 

Project Number 
Project number issued by the Surveyor General Branch is made of the year, the 
operating area and a sequential number (for example, 201912052, opened in 
Saskatchewan in 2019). 

Protected Area 
Protected lands as a result of the public interest or common good. In the Canada 
Lands Survey System, these areas can include habitat, wilderness areas and other 
special management areas. 

Quad 
A division of land used in the territories and defined by the National Topographic 
System (NTS) Quads sheets, which divide areas in a systematic pattern and allows 
parcels to be given a unique Parcel Identifier in the Canada Lands Survey System. 

Reference and  
Index Document 

Reference and Index Documents are used for documents that are not survey 
documents. For the most part, they will be documents prepared for a client or for 
internal office use, which could have the purpose of assisting with planning or 
depicting various situational information. For example, index maps could be used by 
office staff to track instruments and land transfers on a reserve. Mapping prepared 
for requests and projects would also fall into this category as these items would be 
recorded in the CLSR at that time. 

Registration Plan 

A Registration Plan is a type of administrative plan. The registration plan is no longer a 
product used since 2015. It is a graphical description of the boundaries prepared from 
information contained in existing documents, field notes of survey, controlled aerial 
photographs or maps and from information found in land transaction documents. 

Related Plan Allows searching with a plan number to find all the plans or documents associated 
with it. 

Report See Survey Report. 

Right-of-Way A parcel, corridor, or other physical tract of land used for the passage of people, 
vehicles, or materials such as oil and gas, electricity, telecommunications, or water. 

Road and Railroad Allows searching for surveys whose purpose is to create roads or railroads in the 
Canada Lands Survey System. 
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Settlement 
Land Claim

Allows searching in the Canada Lands Survey System for survey documents related to 
lands transferred to aboriginal groups in accordance with the provisions of land claim 
settlement legislation as well as lands created under Comprehensive Land Claims 
Process that do not or will not have Indian Reserve status under the Indian Act. 

Site Plan Plan showing the property “as it is built” or “as-built” at a particular point in time. 

Subdivision Action of dividing a piece of land into two or more parcels or lots. Within the Canada 
Lands Survey System, subdivisions are used in the Yukon to identify parcels of land. 

Survey Fabric 

Survey fabric, also known as cadastral fabric, cadastral datasets or digital cadastral 
data are amalgamations of all the parcels and plan information. This amalgamation 
can be used to support planning and management, but should not be used for 
defining boundaries. 

Survey Plan 

A plan that defines boundaries and parcels of land. A survey plan is used to describe 
one or more parcels. There are different types of Canada Lands survey plans: 
administrative plans, compiled plans, explanatory plans, official plans and  
registration plans. 

Survey Plan Search The Survey Plan Search is a text-based search tool for all current and historical 
records in the Canada Lands Survey System. 

Survey Project Search The Survey Project Search is a text-based search tool for in-progress survey projects 
in the Canada Lands Survey System. 

Survey Records In the Canada Lands Survey System, survey records are the legal survey documents 
(plans, field notes, reports, etc.). 

Survey Report 
In the Canada Lands Survey System, a survey report is used when more information 
or documentation is required than that shown on the submitted plans and/or  
field notes. 

Survey Sketch Drawing or plan which purpose is to present a sketch of an area. Some sketches are 
recorded in the CLSS but are not approved or confirmed by the Surveyor General.

Surveyor The surveyor makes the connection between the description of the land as presented 
on paper or in the digital world and the reality in the field. 

Surveyor General 
Branch (SGB) 

The Surveyor General Branch includes the Surveyor General and his employees. The 
Surveyor General has the legal responsibility, subject to the direction of the Minister of 
Natural Resources, to manage all surveys on Canada Lands and to maintain all the 
original plans, journals, field notes and other documents connected with those surveys. 
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Surveyor General 
Branch Regional Office 

The regional structure of SGB allows to be responsive to the needs of people working 
with the Canada Lands Survey System. To contact your Surveyor General Branch 
Regional Office : 

• Alberta Regional Office
• Atlantic Regional Office
• British Columbia Regional Office
• Manitoba Regional Office
• Northwest Territories Regional Office
• Nunavut Regional Office
• Ontario Regional Office
• Quebec Regional Office
• Saskatchewan Regional Office
• Yukon Regional Office

Surveys In Progress Survey work currently underway. 

Township 
A land division system used in Canada that divides up the lands into sections of one 
square mile on township plans. The Canada Lands Survey System allows searching for 
township information throughout the prairie provinces. 

Water Boundary 
A boundary of an upland parcel bounded by a body of water. It can be the water’s 
edge, the vegetation edge, the mean high water mark (MHWM), the ordinary high 
water mark (OHWM), the mean low water mark (MLWM), or ad medium filum (amf). 

Zoning and Land Use Allows searching for surveys whose purpose is to create zoning and land use in the 
Canada Lands Survey System. 

https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#ab
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#ns
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#bc
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#mb
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#nt
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#nu
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#to
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#qc
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#sk
https://www.nrcan.gc.ca/surveyor-general-branch-offices/11070#yt
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